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ABSTRACT 

 

Internet of Things (IoT) is a very fast growing technology and the field of IoT is extending 

its wings in every one of the areas today. With the progression in computers like Node 

MCU micro-controller the innovation is achieving the ground level with its application in 

farming and aquaculture. Sensor acquisition is conducted by Node MCU micro controller 

is used as data processing device as well as server. Here we use Node MCU, SMPS, 

Ultrasonic sensor, Temperature sensor, Rain sensor.  A user can monitor the water 

condition, water temperature and weather condition (Rain) using an android app through 

Wi-Fi  through Internet from anywhere in the world. Fish is a rich source of vitamins, 

minerals, protein, nutrients and micro nutrients. Farmers need real time and accurate 

information to monitor the farm surrounding condition. In previous this parameters was 

checked in manually. In this study, we proposed an Internet of Things (IoT) based smart 

fisharing management model that will measure water level, water temperature of pond and 

weather rain condition. In this work uses low cost and long range monitoring system. This 

system will be consume time and cost at a time and very helpful for this time.  
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CHAPTER 1 

INTRODUCTION 

 

1.1 Introduction 

In the recent years with advancement in monitoring and automation technology, research 

in aquaculture resulted in development of production technologies that improved the quality 

of the fish farming ponds, thus leading to improvement and increasing of fish production. 

Fish farming pond is an artificial man-made eco-system and on the most basic level we can 

differentiate two types of ponds, ponds that breed tropical fish that are used as pets 

commonly known as aquariums instead of ponds, and ponds that breed fish for food. Our 

focus in this paper are the ponds that bread fish for food, typically build and maintained in 

remote eco-clean areas, near to water springs, and any outside environmental stress will 

negatively impact on the fish production. This is due to the fact that fish are cold-blooded 

animals that regulate their temperature directly by the surrounding environment. 

Consequently on this, “temperature is one of the many key parameters that is needed to be 

monitored, combined with other important factors like light intensity, water level in the 

pond and etc”.  

 

Therefore, the monitoring of this eco-system is a problem combined of some multiple sub 

problems that are linked between each other, and they are in constant interactions. Their 

interaction is a complex process that needs a lot of time, dedications and knowledge by 

humans to be controlled and maintained. Aquaculture, otherwise called water cultivating, 

is the cultivating of amphibian life forms, for example, fish, shellfish and crabs by utilizing 

the different sensors to lessen the dangers. IoT has effectively demonstrated its enormous 

measure of uses areas in the most recent years. Notwithstanding, little are the fish cultivates 

today outfitted with clever gadgets with real-time and associated water observing abilities. 

There are numerous precedents where IoT could assist aqua cultura lists with improving 

their working conditions. For instance, some fish ranches are far from the land and utilizing 

IoT to screen water at a separation could decrease their expenses. Another model is that 

adjustments in water quality can happen in all respects rapidly and whenever, so observing 

water continuously with cautions cannot miss a specific occasion.  
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Fisheries and aquaculture bolster the earnings and occupations of 660-820 million 

individuals, around 10-12 percent of the total populace. The part has an essential task to 

carry out in sexual orientation fairness, neediness and sustenance security. With worldwide 

fish supply more than 150 million tons, in excess of 85 percent of this supply is utilized 

straightforwardly for sustenance; providing 15 percent of the world's protein and 

fundamental nourishment for around 4.3 billion customers.  

 

1.2 Motivation 

Fishery management system is getting better day by day, if the management system is not 

digitized. Many things have to be done manually in many fishsering system. We can 

monitor various condition of pond. Mainly we can remotely collect weather reports such as 

water temperature, water volume and whether it is raining or not. Previous system has more 

limitation so we arrange more feature in this system. This system will be work very well. 

That’s why we try to make this system. 

 

1.3 Objectives 

The objectives of this project are:  

a) To study about Automatic IoT Fishering Management System. 

b) To design and construct a Automatic IoT Fishering Management System 

c) To test the performance of the Automatic IoT Fishering Management System. 

 

1.4 Organization of the Book 

 Chapter 1: Introduction. This chapter is all about background study, motivation, 

Objectives and thesis book organization. 

 

 Chapter 2: Literature Review- Here briefly describe about previous book review, 

Block diagram, Circuit Diagram, Components List and Summary of this chapter. 

 

 Chapter 3: Hardware and Software Analysis- This chapter is discussed about our 

project hardware and Software . Here we describe our hole instrument details. 
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 Chapter 4: Methodology– Here briefly discuss about project methodology, 

working principle and our system overview. 

 

 Chapter 5: Results and Discussion– Here briefly discuss about project discussion, 

result analysis, advantages, application and our system overview. 

 

 Chapter 6: Conclusion – This chapter is all about our thesis future 

recommendation and this project conclusion. 
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CHAPTER 2 

LITERATURE REVIEW 

 

2.1 Introduction 

This chapter mainly reviews literature, reviews of various types of work and highlights the 

importance of IoT fishing management in such situations. 

 

2.2 Literature Review 

Fowler et.al. [1] proposed the concept of recirculating Aquaculture Systems. In this paper, 

“they used temperature, DO, and pH scale be monitored directly on a continuous basis since 

they have an inclination to alter quickly and have a big adverse result on the system if 

allowed to work out-of-range”. Therefore, these three parameters are chosen to be 

monitored in this system.  

Merino et.al. [2] examined the achievability of supporting present and expanded per capita 

fish utilization rates in 2050 dependent on broad information: expectations of changes in 

worldwide and local atmosphere, marine biological system and fisheries creation gauges, 

human populace gauges, fishmeal and oil value estimations and projections of the 

innovative improvement in aquaculture innovation. They reason that gathering present and 

bigger utilization rates is possible, regardless of a developing populace and the effects of 

environmental change on potential fisheries creation. Notwithstanding, it is conceivable 

just if fish assets are overseen reasonably and fisheries the executives are powerful. The 

fisheries the executives depends absolutely on the water quality checking. Fish infections 

are successive and sway straightforwardly the collecting yield [3].  

A low water quality can likewise affect the fish development and postpone the gather. 

Today, the water observing frameworks are over the top expensive and absence of 

affectability. Executing and keeping up this sort of framework is assets expending. A great 

deal of little maker decide not to utilize it and go out on a limb to get a littler yield. That is 

the reason water quality is the way to achievement in aquaculture and improves water 

quality is a major test, particularly in little fish cultivates in creating nations.  
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Ceong et. al [4] proposed partner degree eco water ranch framework that screens water 

temperature, broke down oxygen and saltiness. The framework may likewise send partner 

degree caution to the ranchers once the scopes of ecological data square measure observed 

to be anomalous.  

Han et. al [5] exhibited style on setting watching framework for development ranches. The 

arranged framework offers omnipresent access to the checked information from the lake 

either from the net or on the cell phones. Shifeng et. al [6] examined and suggest a 

framework that is bolstered remote RF and GSM to gauge such parameters as disintegrated 

substance component and Pacheco.O [7] fish are cold-blooded animals, regulating their 

body temperature directly by the water environment. Changes in water temperature affect 

the amount of dissolved oxygen in the water and fish oxygen consumption. Although the 

fish can withstand a broad water temperature range, any sudden, extreme changes in water 

temperature will have a considerable impact on fish physiology. A chilling injury will cause 

the fish to rush into, paralysis with a loss of balance, leading to death. The reason may be 

the respiratory center, or osmotic regulation is affected at high temperatures. As the water 

temperature increases the fish suffer respiratory arrest.  

Wen-Tsai Sung [8] found that the amount of dissolved oxygen in water increases/decreases 

based on seasons.  When the amount of dissolved oxygen in water is reduced below certain 

limit then fish growth will be hindered. When amount of dissolved oxygen becomes lower 

than the fish survival conditions the fish will die. P. Bartolome [9] in general fish farming 

the acidity and alkaline of the water should be maintained between 6 to 8. Too acidic or 

alkaline will cause adverse effects, acid erosion of the gill tissue, tissue coagulation necrosis, 

increased mucus secretion, abdominal congestion and inflammation. If the PH value is less 

than 4.5, the fish will die. D.YusufMulge [10] temperature sensor are used to deliver the 

temperature information on a fire extinguishers to website, email-id, and mobile phone 

number.  

In this manner, response to fire emergencies is made with in fraction of seconds. Paraguas 

M M [11] wireless networks have different security issues in the wireless communication. 

Wi-Fi Protected Access 2 (WPA2) uses Advanced Encryption Standard (AES) encryption 

an has more security compared to Wi-Fi Protected Access (WPA). Jayavardhana G [12] the 

buzzwords in Information Technology are Internet of Things (IoT). Internet of Things will 

transform real world objects into intelligent virtual objects. Aim of IoT is to unify world 
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under a common infrastructure, giving control of things around us. Gigli, M [13] the pH 

measurement is potentiometric that is, it explains the relationship between the electrode 

potential and the solution. The meter truthfully responds to the potential, it indirectly and 

mathematically converts it.  

Fish farming refers to farming variety of marine species such as shellfish, sport fish, bait 

fish, ornamental fish, crustaceans, mollusks, algae, sea vegetables, and fish eggs to breed, 

rear and harvest in different water environments such as ponds, rivers, lakes, and ocean. 

Fish are coldblooded animals, regulating their body temperature directly by the water 

environment. Changes in water temperature affect the amount of dissolved oxygen in the 

water and fish oxygen consumption[14].  

Although the fish can withstand a broad water temperature range, any sudden, extreme 

changes in water temperature will have a considerable impact on fish physiology. A chilling 

injury will cause the fish to rush into, paralysis with a loss of balance, leading to death. The 

reason may be the respiratory center, or osmotic regulation is affected at high temperatures. 

As the water temperature increases the fish suffer respiratory arrest. [15]Fish World 

magazine found that the amount of dissolved oxygen in water increases or decreases with 

the seasons.  

When the water temperature rises, fish metabolic rate will be increased and results in less 

dissolved oxygen in the water. Low water temperature decreases fish metabolic rate and 

increases amount of dissolved oxygen in the water. If the amount of dissolved oxygen in 

water is reduced to below a certain limit fish growth will be hindered. When the amount of 

dissolved oxygen becomes lower than the fish survival conditions the fish will die[16]. 

 

2.3 Block Diagram 

In our project we have set up an Automatic IoT Fishering Management System. In this 

circuit we have used one Node MCU micro controller for master controller unit. Here we 

also use a SMPS, ultrasonic sensor, temperature sensor, rain sensor, LCD display etc. In 

this diagram we will show by block the individual parts.  
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Figure 2.1: Block Diagram of Automatic IoT Fishering Management System.  

 

 

2.4  Circuit Diagram  

The schematic diagram here is representing the electrical circuit and the components of the 

Automatic IoT Fishering Management System. Here we connect equipment with he 

smart wire connection.  

 
Figure 2.2: Schematic Diagram of Automatic IoT Fishering Management System. 
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2.5 Components List: 

Hardware Part: 

1. Node MCU 

2. SMPS 

3. Temperature Sensor 

4. Rain Sensor 

5. Ultrasonic Sensor 

6. LCD Display 

7. Voltage Regulator 

8. Resistor 

 

Software Part: 

1. Arduino IDE 

2. Proteus  

3. Remote XY 

 

 

2.6 Summary 

The above discussion gives an idea about the Automatic IoT Fishering Management 

System. All that work on robots has already been done here, and the results of their work, 

the use of IoT Fishering Management System in the  situation are described in detail. From 

this we also got the direction of work of the project. 
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CHAPTER 3 

HARDWARE AND SOFTWARE ANALYSIS 

 

3.1 Node MCU 

Node MCU is an open-source firmware for which open-source prototyping board designs are 

available. The name "Node MCU" combines "node" and "MCU" (micro-controller unit). The 

term "Node MCU" strictly speaking refers to the firmware rather than the associated 

development kits.  

Both the firmware and prototyping board designs are open source. The firmware uses the Lua 

scripting language. The firmware is based on the eLua project, and built on the Espressif Non-

OS SDK for ESP8266. It uses many open source projects, such as lua-cjson and SPIFFS. Due 

to resource constraints, users need to select the modules relevant for their project and build a 

firmware tailored to their needs. Support for the 32-bit ESP32 has also been implemented. 

 

Figure 3.1: Node MCU 

The prototyping hardware typically used is a circuit board functioning as a dual in-line 

package (DIP) which integrates a USB controller with a smaller surface-mounted board 

containing the MCU and antenna. The choice of the DIP format allows for easy prototyping 

on breadboards. The design was initially was based on the ESP-12 module of the ESP8266, 

which is a Wi-Fi SoC integrated with a Tensilica Xtensa LX106 core, widely used in IoT 

applications. 

 



 

 10 

 

 

 

 

 

 

 

 

Figure 3.2: Node MCU Schematic Diagram 

 

This an open source IoT platform. It includes firmware which runs on the ESP8266 Wi-

Fi SoC from Express if Systems, and hardware which is based on the ESP-12 module. The 

term "Node MCU" by default refers to the firmware rather than the development kits. The 

firmware uses the Luascripting language. It is based on the eLua project, and built on the 

Espress if Non-OS SDK for ESP8266. Node MCU was created shortly after 

the ESP8266 came out. On December 30, 2013, Espressif Systems  began production of 

the ESP8266. The ESP8266 is a Wi-Fi SoC integrated with a Tensilica Xtensa LX106 core, 

widely used in IoT applications (see related projects). Node MCU started on 13 Oct 2014, 

when Hong committed the first file of node mcu-firmware to GitHub. Two months later, 

the project expanded to include an open-hardware platform when developer Huang R 

committed the gerber file of an ESP8266 board, named devkit v0.9. Later that month, Tuan 

PM ported MQTT client library from Contiki to the ESP8266 SoC platform, and 

committed to NodeMCU project, then Node MCU was able to support the MQTT IoT 

protocol, using Lua to access the MQTT broker. Another important update was made on 

30 Jan 2015, when Devsaurus ported the u8glibto Node MCU project, enabling Node MCU 

to easily drive LCD, Screen, OLED, even VGA displays. In summer 2015 the creators 

abandoned the firmware project and a group of independent contributors took over.  

https://en.wikipedia.org/wiki/Internet_of_Things
https://en.wikipedia.org/wiki/Firmware
https://en.wikipedia.org/wiki/ESP8266
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/Wi-Fi
https://en.wikipedia.org/wiki/System_on_a_chip
https://en.wikipedia.org/w/index.php?title=Espressif_Systems&action=edit&redlink=1
https://en.wikipedia.org/wiki/Lua_(programming_language)
https://en.wikipedia.org/wiki/ESP8266
https://en.wikipedia.org/w/index.php?title=Espressif_Systems&action=edit&redlink=1
https://en.wikipedia.org/wiki/Tensilica
https://en.wikipedia.org/wiki/NodeMCU#Related_projects
https://en.wikipedia.org/wiki/Gerber_format
https://en.wikipedia.org/wiki/MQTT
https://en.wikipedia.org/wiki/Contiki
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Figure 3.3: Node MCU Pin Out 

 

Node MCU V3 ESP8266 ESP-12E is Wi-Fi development board that helps you to prototype 

your IoT product with few Lua script lines, or through Arduino IDE. The board is based on 

ESP8266 ESP-12E variant, unlike other ESP-12E, you won’t need to buy a separate 

breakout board, USB to serial adapter, or even solder it to a PCB to get started, you will 

only need a USB cable (Micro USB). 

Features 

1. Communication interface voltage: 3.3V. 

2. Antenna type: Built-in PCB antenna is available. 

3. Wireless 802.11 b/g/n standard 

4. WiFi at 2.4GHz, support WPA / WPA2 security mode 

5. Support STA/AP/STA + AP three operating modes 

6. Built-in TCP/IP protocol stack to support multiple TCP Client connections 

(5 MAX) 

7. D0 ~ D8, SD1 ~ SD3: used as GPIO, PWM, IIC, etc., port driver capability 

15mA 

8. AD0: 1 channel ADC 

9. Power input: 4.5V ~ 9V (10VMAX), USB-powered 
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10. Current: continuous transmission: ≈70mA (200mA MAX), Standby: 

<200uA 

11. Transfer rate: 110-460800bps 

 

3.2 Switch Mode Power Supply (SMPS) 

A switched-mode power supply (switching-mode power supply, switch-mode power 

supply, switched power supply, SMPS, or switcher) is an electronic power supply that 

incorporates a switching regulator to convert electrical power efficiently. Unlike a linear 

power supply, the pass transistor of a switching-mode supply continually switches between 

low-dissipation, full-on and full-off states, and spends very little time in the high dissipation 

transitions, which minimizes wasted energy. A hypothetical ideal switched-mode power 

supply dissipates no power. Voltage regulation is achieved by varying the ratio of on-to-

off time (also known as duty cycles). 

 

 

 

 

 

 

 

 

           Figure 3.4: SMPS 

 

Switching regulators are used as replacements for linear regulators when higher efficiency, 

smaller size or lighter weight are required. They are, however, more complicated; their 

switching currents can cause electrical noise problems if not carefully suppressed, and 

simple designs may have a poor power factor. Switched-mode power supplies are classified 

according to the type of input and output voltages. The four major categories are: 

https://en.wikipedia.org/wiki/Power_supply
https://en.wikipedia.org/wiki/Voltage_regulator#Switching_regulators
https://en.wikipedia.org/wiki/Electrical_power_conversion
https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Dissipation
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Duty_cycle
https://en.wikipedia.org/wiki/Power_factor
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 AC to DC 

 DC to DC 

 DC to AC 

 AC to AC 

 

A basic isolated AC to DC switched-mode power supply consists of: 

 Input rectifier and filter 

 Inverter consisting of switching devices such as MOSFETs 

 Transformer 

 Output rectifier and filter 

 Feedback and control circuit 

 

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on 

and off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET or 

power transistors. The high-frequency voltage pulses from the inverter are fed to the 

transformer primary winding, and the secondary AC output is rectified and smoothed to 

produce the required DC voltages. A feedback circuit monitors the output voltage and 

instructs the control circuit to adjust the duty cycle to maintain the output at the desired 

level. 

 

Figure 3.5: SMPS Circuit 
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Basic working concept of an SMPS 

A switching regulator does the regulation in the SMPS. A series switching element turns 

the current supply to a smoothing capacitor on and off. The voltage on the capacitor controls 

the time the series element is turned. The continuous switching of the capacitor maintains 

the voltage at the required level. 

Design basics 

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave 

bridge rectifier. The rectified voltage is next applied to the power factor correction (PFC) 

pre-regulator followed by the downstream DC-DC converter(s). Most computers and small 

appliances use the International Electrotechnical Commission (IEC) style input connector. 

As for output connectors and pinouts, except for some industries, such as PC and compact 

PCI, in general, they are not standardized and are left up to the manufacturer. There are 

different circuit configurations known as topologies, each having unique characteristics, 

advantages and modes of operation, which determines how the input power is transferred 

to the output. Most of the commonly used topologies such as flyback, push-pull, half bridge 

and full bridge, consist of a transformer to provide isolation, voltage scaling, and multiple 

output voltages. The non-isolated configurations do not have a transformer and the power 

conversion is provided by the inductive energy transfer. 

Advantages of switched-mode power supplies: 

 Higher efficiency of 68% to 90% 

 Regulated and reliable outputs regardless of variations in input supply voltage 

 Small size and lighter 

 Flexible technology 

 High power density 

 

Disadvantages: 

 Generates electromagnetic interference 

https://www.electronicsforu.com/electronics-projects/power-factor-correction
https://www.iec.ch/about/?ref=menu
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 Complex circuit design 

 Expensive compared to linear supplies 

Switched-mode power supplies are used to power a wide variety of equipment such as 

computers, sensitive electronics, battery-operated devices and other equipment requiring 

high efficiency. 

Switch Mode Power Supply 

 

Figure 3.6: SMPS Circuit Connection  

Linear voltage IC regulators have been the basis of power supply designs for many years 

as they are very good at supplying a continuous fixed voltage output.Linear voltage 

regulators are generally much more efficient and easier to use than equivalent voltage 

regulator circuits made from discrete components such a zener diode and a resistor, or 

transistors and even op-amps. The most popular linear and fixed output voltage regulator 

types are by far the positive output voltage series, and the  negative output voltage series. 

These two types of complementary voltage regulators produce a precise and stable voltage 

output ranging from about 5 volts up to about 24 volts for use in many electronic 

circuits.There is a wide range of these three-terminal fixed voltage regulators available each 

with its own built-in voltage regulation and current limiting circuits. This allows us to create 

a whole host of different power supply rails and outputs, either single or dual supply, 

suitable for most electronic circuits and applications. There are even variable voltage linear 

regulators available as well providing an output voltage which is continually variable from 

just above zero to a few volts below its maximum voltage output. 
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Most d.c. power supplies comprise of a large and heavy step-down mains transformer, 

diode rectification, either full-wave or half-wave, a filter circuit to remove any ripple 

content from the rectified d.c. producing a suitably smooth d.c. voltage, and some form of 

voltage regulator or stabiliser circuit, either linear or switching to ensure the correct 

regulation of the power supplies output voltage under varying load conditions. Then a 

typical d.c. power supply would look something like this: 

Typical DC Power Supply 

 

  

These typical power supply designs contain a large mains transformer (which also provides 

isolation between the input and output) and a dissipative series regulator circuit. The 

regulator circuit could consist of a single zener diode or a three-terminal linear series 

regulator to produce the required output voltage. The advantage of a linear regulator is that 

the power supply circuit only needs an input capacitor, output capacitor and some feedback 

resistors to set the output voltage. 

 

3.3 5V Regulator IC 

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage 

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC, 

a member of 78xx series of fixed linear voltage regulators used to maintain such 

fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx indicates 

the output voltage it provides. 7805 IC provides +5 volts regulated power supply with 

provisions to add a heat sink.  
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7805 IC Rating: 

 Input voltage range 7V- 35V  

 Current rating Ic = 1A  

 Output voltage range V. Max=5.2V ,V. Min=4.8V 

 

Figure 3.7: 5V Regulator IC 

3.4 Ultrasonic Sensor 

An ultrasonic sensor is an electronic device that measures the distance of a target object 

by emitting ultrasonic sound waves, and converts the reflected sound into an electrical 

signal. Ultrasonic waves travel faster than the speed of audible sound (i.e. the sound that 

humans can hear). Ultrasonic sensors have two main components: the transmitter (which 

emits the sound using piezoelectric crystals) and the receiver (which encounters the sound 

after it has travelled to and from the target). 

 

HC-SR04 Ultrasonic Sensor - Working 

As shown above the HC-SR04 Ultrasonic (US) sensor is a 4 pin module, whose pin names 

are Vcc, Trigger, Echo and Ground respectively. This sensor is a very popular sensor used 

in many applications where measuring distance or sensing objects are required. The module 
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has two eyes like projects in the front which forms the Ultrasonic transmitter and Receiver. 

The sensor works with the simple high school formula that 

Distance = Speed × Time 

The Ultrasonic transmitter transmits an ultrasonic wave, this wave travels in air and when 

it gets objected by any material it gets reflected back toward the sensor this reflected wave 

is observed by the Ultrasonic receiver module as shown in the picture below- 

 

 
Figure 3.8: Working of sensor 

 

Now, to calculate the distance using the above formulae, we should know the Speed and 

time. Since we are using the Ultrasonic wave we know the universal speed of US wave at 

room conditions which is 330m/s. The circuitry inbuilt on the module will calculate the 

time taken for the US wave to come back and turns on the echo pin high for that same 

particular amount of time, this way we can also know the time taken. Now simply calculate 

the distance using a microcontroller or microprocessor. 

 

How to use the HC-SR04 Ultrasonic Sensor 

HC-SR04 distance sensor is commonly used with both microcontroller and 

microprocessor platforms like Arduino, ARM, PIC, Raspberry Pie etc. The following guide 

is universally since it has to be followed irrespective of the type of computational device 

used.Power the Sensor using a regulated +5V through the Vcc ad Ground pins of the sensor. 

The current consumed by the sensor is less than 15mA and hence can be directly powered 

by the on board 5V pins (If available). The Trigger and the Echo pins are both I/O pins and 

hence they can be connected to I/O pins of the microcontroller. To start the measurement, 

the trigger pin has to be made high for 10uS and then turned off. This action will trigger an 
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ultrasonic wave at frequency of 40Hz from the transmitter and the receiver will wait for the 

wave to return. Once the wave is returned after it getting reflected by any object the Echo 

pin goes high for a particular amount of time which will be equal to the time taken for the 

wave to return back to the sensor.The amount of time during which the Echo pin stays high 

is measured by the MCU/MPU as it gives the information about the time taken for the wave 

to return back to the Sensor. Using this information, the distance is measured as explained 

in the above heading. 

 

Applications 

● Used to avoid and detect obstacles with robots like biped robot, obstacle avoider 

robot, path finding robot etc. 

● Used to measure the distance within a wide range of 2cm to 400cm 

● Can be used to map the objects surrounding the sensor by rotating it 

● Depth of certain places like wells, pits etc can be measured since the waves can 

penetrate through water 

 

Ultrasonic Sensor Pin Configuration 

Table 01:  Ultrasonic Sensor Pin Description 

 

Pin 

Number 
Pin Name Description 

1 Vcc The Vcc pin powers the sensor, typically with +5V 

2 Trigger 
Trigger pin is an Input pin. This pin has to be kept high 

for 10us to initialize measurement by sending US wave. 

3 Echo 

Echo pin is an Output pin. This pin goes high for a 

period of time which will be equal to the time taken for 

the US wave to return back to the sensor. 

4 Ground This pin is connected to the Ground of the system. 
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HC-SR04 Sensor Features 

● Operating voltage: +5V 

● Theoretical Measuring Distance: 2cm to 450cm 

● Practical Measuring Distance: 2cm to 80cm 

● Accuracy: 3mm 

● Measuring angle covered: <15° 

● Operating Current: <15mA 

● Operating Frequency: 40Hz 

 

3.5 Temperature Sensor 

The DHT11 is a basic, ultra-low-cost digital temperature and humidity sensor. It uses a 

capacitive humidity sensor and a thermistor to measure the surrounding air, and spits out a 

digital signal on the data pin (no analog input pins needed). It’s fairly simple to use, but 

requires careful timing to grab data. 

DHT11 Specifications: 

 Operating Voltage: 3.5V to 5.5V 

 Operating current: 0.3mA (measuring) 60uA (standby) 

 Output: Serial data 

 Temperature Range: 0°C to 50°C 

 Humidity Range: 20% to 90% 

 

 

 Figure 3.9: DHT11 Temperature Sensor 
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3.6 Rain sensor 

A rain sensor is one kind of low-cost electronic sensor which is used to detect the rainfall or 

water drops. It works as a switch. Normally the switch is open condition. This sensor is 

consists of mainly two parts, one is Sensing Pad and another one is the Sensor Module. When 

rainfall or water drops fall on the Sensing Pad surface, then the switch will be closed. The 

Sensor Module reads data from the sensor pad and processes the data and converts it into a 

digital/analog output. So, the sensor can provide both types of output Digital output 

(DO) and Analog output(AO). 

 

Figure 3.10: Rain Sensor Pin Diagram 

The Rain Sensor Module’s Sensing Pad consists of two nickel-coated series copper tracks. 

Also, it has two Header pins, these are internally connected to the two copper tracks of the 

Sensing Pad. These pins are used to connect the Sensing Pad to the rain sensor module 

circuit through two jumper wire. Always, one pin of the rain sensor circuit provides a +5v 

power supply to the one track of the sensing pad, and another pin is received the return 

power supply from another track of the sensing pad. Normally under dry conditions, the 

sensing pad provides high resistance and low conductive. So, the 5v power supply cannot 

be passed from one track to another track. Its resistance varies according to the amount of 

water on the surface of the sensing pad. When water drops fall on the sensor pad surface 

its resistance will decrease and conductivity will increase. So, when water drops increase 

on the pad surface it can pass more power supply through one track to another track. 
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Figure 3.11: Rain Sensor Pin Indication & Description 

Table 02 : Rain sensor Pin Description 

 

Sensor 

Module Hardware Overview 

The Sensor module is consists of some key components. These are LM393 Comparators, 

Variable Resistor (Trimpot), Power LED, output LED. 

Rain Sensor Specifications 
 

Table 03: Rain Sensor Specialization 

Parameter Value 

Operating Voltage 3.3V – 5V 

Operating Current 15 mA 

Comparator chip LM393 

Pin No Pin Name Description 

1 VCC +5 v power supply 

2 GND Ground (-) power supply 

3 DO Digital Output  (0 or 1) 

4 AO Analog Output  (range 0 to 1023) 

https://www.electroduino.com/lm393-comparator-ic-pinout-specifications-working-principle/
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Sensitivity Adjustable via Trimpot 

Output type Analog output voltage (AO) and Digital switching 

voltage (DO) 

LED lights indicators Power (red/green) and Output (red/green) 

Sensing pad 5cm x 4 cm nickel plate on one side. 

Module PCB Size 3.2cm x 1.4cm 

 
Applications 

 Rainfall detection 

 It’s used in an irrigation system, when rainfall is started it shut down the watering 

system automatically. 

 

3.7 LCD Display  

The 16 × 2 LCD pin shown below: 

• Pin1 (Low / Source PIN): This is a GND display pin, used to connect the GND end 

of a microcontroller unit or power source. 

• Pin2 (VCC / Source Pin): This is a display power supply pin, used to connect a 

power supply pin. 

• Pin3 (V0 / VEE / Control Pin): This pin controls the difference of the display, which 

is used to connect a flexible POT that can deliver 0 to 5V. 

• Pin4 (Register Select / Control Pin): This pin turns between a command or data 

register, which is used to connect a microcontroller unit pin and gets 0 or 1 (0 = data 

mode, and 1 = command mode) . 

• Pin5 (Read / Write / Control Pin): This pin shifts the display between the read or 

written function, and is connected to the microcontroller unit pin to get 0 or 1 (0 = 

Write Task, and 1 = Read Task ). 

• Pin 6 (Enable / Manage Pin): This pin should be held at the top to perform the 

reading / writing process, and is connected to the microcontroller unit and kept kept 

high. 

• 7-14 Anchors (Data Anchors): These anchors are used to send data to the display. 
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These pins are connected to two wiring modes such as 4-wire mode and 8-wire 

mode. In 4-wire mode, only four pins are connected to the microcontroller unit such 

as 0 to 3, and in 8-wire mode, 8 pins are connected to the microcontroller unit as 0 

to 7. 

• Pin15 (+ ve LED pin): This pin is connected to + 5V 

• Pin 16 (-ve LED pin): This pin is connected to GND. 

 

 

Figure 3.12: LCD Display 

Features of LCD 16x2 

The features of this LCD mainly include the following. 

 The operating voltage of this LCD is 4.7V-5.3V 

 It includes two rows where each row can produce 16-characters. 

 The utilization of current is 1mA with no backlight 

 Every character can be built with a 5×8-pixel box 

 The alphanumeric LCDs alphabets & numbers 

 Is display can work on two modes like 4-bit & 8-bit 

 These are obtainable in Blue & Green Backlight 

 It displays a few custom generated characters 
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3.8 Resistor 

A resistor is a passive two-terminal electrical component that implements electrical 

resistance as a circuit element. Resistors act to reduce current flow, and, at the sometime, 

act to lower voltage levels within circuits. Resistors may have fixed resistances or variable 

resistances, such as those founding thermostats, visitors, trimmers, photo resistors, 

hamsters and potentiometers. The current through a resistor is in direct proportion to the 

voltage across the resistor's terminals. This relationship is represented by Ohm's law. 

 

 

 

Figure 3.13: Resistor 

 

 

Theory of operation: 

 

The behavior of an ideal resistor is dictated by the relationship specified by Ohm ‘slaw: 

V = I.R 

 

Ohm's law states that the voltage (V) across a resistor is proportional to the current (I), 

where the constant of proportionality is the resistance (R). 

 

Equivalently, Ohm's law can be stated: 

I = V/R 

 

This formulation states that the current (I) is proportional to the voltage (V) and inversely 

proportional to the resistance (R). This is directly used in practical computations. For 

example, if a 300 ohm resistor is attached across the terminals of a12 volt battery, then a 

current of12 / 300 = 0.04 amperes flows through that resistor. 
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3.9 Arduino IDE 

The digital microcontroller unit named as Arduino Nano can be programmed with the 

Arduino software IDE. There is no any requirement for installing other software rather than 

Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to the 

microcontroller on our board). The IC used named as ATmega328 on the Arduino Nano 

comes pre burned with a boot loader that allows us to upload new code to it without the use 

of an external hardware programmer. 

Communication is using the original STK500 protocol (reference, C header files). We can 

also bypass the boot loader and programs the microcontroller through the ICSP (In Circuit 

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot 

loader, which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of 

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling 

the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode. 

The Arduino Nano is one of the latest digital microcontroller units and has a number of 

facilities for communicating with a computer, another Arduino, or other microcontrollers. 

The ATmega328 provides UART TTL at (5V) with serial communication, which is 

available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the 

data. An ATmega16U2 on the board channels this serial communication over USB and 

appears as a virtual com port to software on the computer. The '16U2 firmware uses the 

standard USB COM drivers, and no external driver is needed. However, on Windows, an 

.in file is required. The Arduino software includes a serial monitor which allows simple 

textual data to be sent to and from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-

to-serial chip and USB connection to the computer (but not for serial Communication on 

pins 0 and 1). A Software Serial library allows for serial communication on any of the 

Nano's digital pins. The ATmega328 also supports I2C (TWI) and SPI communication. 
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Figure 3.14: Arduino Software Interface IDE 

 The Arduino software includes a Wire library to simplify use of the I2C bus. Arduino 

programs are written in C or C++ and the program code written for Arduino is called sketch. 

The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs, and for 

uploading the programs it uses argued. As the Arduino platform uses Atmel micro-

controllers, Atmel's development environment, AVR Studio or the newer Atmel Studio, 

may also be used to develop software for the Arduino. The Arduino Integrated 

Development Environment - or Arduino Software (IDE) - contains a text editor for writing 

code, a message area, a text console, a toolbar with buttons for common functions and a 

series of menus. It connects to the Arduino and Genuino hardware to upload programs and 

communicate with them. 

 

Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension .ino. The editor has features 

for cutting/pasting and for searching/replacing text. The message area gives feedback while 

saving and exporting and also displays errors. The console displays text output by the 
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Arduino Software (IDE), including complete error messages and other information. The 

bottom right hand corner of the window displays the configured board and serial port. The 

toolbar buttons allow you to verify and upload programs, create, open, and save sketches, 

and open the serial monitor. 

Sketchbook 

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store 

your programs (or sketches). The sketches in your sketchbook can be opened from the File 

> Sketchbook menu or from the Open button on the toolbar. The first time you run the 

Arduino software, it will automatically create a directory for your sketchbook. You can 

view or change the location of the sketchbook location from with the Preferences dialog. 

Beginning with version 1.0, files are saved with a .ino file extension. Previous versions use 

the .pde extension. You may still open .pde named files in version 1.0 and later, the software 

will automatically rename the extension to .ino. 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its own 

tab). These can be normal Arduino code files (no visible extension), C files (.c extension), 

C++ files (.cpp), or header files (.h). 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board 

and Tools > Port menus. The boards are described below. On the Mac, the serial port is 

probably something like /dev/tty.usbmodem241 (for a Uno or Mega2560 or Leonardo) or 

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for USB serial device in the 

ports section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx , 

/dev/ttyUSBx or similar. Once you've selected the correct serial port and board, press the 

upload button in the toolbar or select the Upload item from the Sketch menu. Current 

Arduino boards will reset automatically and begin the upload. With older boards (pre-

Diecimila) that lack auto-reset, you'll need to press the reset button on the board just before 
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starting the upload. On most boards, you'll see the RX and TX LEDs blink as the sketch is 

uploaded. The Arduino Software (IDE) will display a message when the upload is complete, 

or show an error. 

When you upload a sketch, you're using the Arduino Bootloader, a small program that has 

been loaded on to the microcontroller on your board. It allows you to upload code without 

using any additional hardware. The Bootloader is active for a few seconds when the board 

resets; then it starts whichever sketch was most recently uploaded to the microcontroller. 

The Bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board 

resets). 

Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and compile 

the library with your sketch. Because libraries are uploaded to the board with your sketch, 

they increase the amount of space it takes up. If a sketch no longer needs a library, simply 

delete its #include statements from the top of your code. There is a list of libraries in the 

reference. Some libraries are included with the Arduino software. Others can be 

downloaded from a variety of sources or through the Library Manager. Starting with 

version 1.0.5 of the IDE, you do can import a library from a zip file and use it in an open 

sketch. See these instructions for installing a third-party library. 

Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your sketchbook 

directory. Platforms installed there may include board definitions (which appear in the 

board menu), core libraries, Bootloaders, and programmer definitions. To install, create the 

hardware directory, then unzip the third-party platform into its own sub-directory. (Don't 

use "Arduino" as the sub-directory name or you'll override the built-in Arduino platform.) 

To uninstall, simply delete its directory. For details on creating packages for third-party 

hardware, see the Arduino IDE 1.5 3rd party Hardware specification. 
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Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial connector. 

To send data to the board, enter text and click on the "send" button or press enter. Choose 

the baud rate from the drop-down menu that matches the rate passed to Serial begin in your 

sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your sketch) 

when you connect with the serial monitor. 

 

3.10  Proteus Software 

The Proteus Design Suite is a proprietary software tool suite used primarily for electronic 

design automation. The software is used mainly by electronics design engineers and 

technicians to create schematics and electronics prints for manufacturing printed circuit 

boards. The first version of what is now the Proteus Design Suite was called PC-B and was 

written by the company chairman, John Jameson, for DOS in 1988.  

 

Figure 3.15: Proteus Software Interface 
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Schematic Capture support followed in 1990 with a port to the Windows environment 

shortly thereafter. Mixed mode SPICE Simulation was first integrated into Proteus in 1996 

and microcontroller simulation then arrived in Proteus in 1998. Shape based auto routing 

was added in 2002 and 2006 saw another major product update with 3D Board 

Visualization. More recently, a dedicated IDE for simulation was added in 2011 and MCAD 

import/export was included in 2015. Support for high speed design was added in 2017. 

Feature led product releases are typically biannual, while maintenance-based service packs 

are released as required.  

 

3.11 Remote XY: 

Remote XY is easy way to make and use a mobile graphical user interface for controller 

boards to control via smartphone or tablet. The system includes: 

 Editor of mobile graphical interfaces for controller boards, located on the site 

remotexy.com 

 Mobile app Remote XY that allows to connect to the controller and control it 

via graphical interface. Download app. 

Distinctive features: 

 The interface structure is stored in the controller. When connected, there is no 

interaction with servers to download the interface. The interface structure is 

downloaded to the mobile application from the controller. 

 One mobile application can manage all your devices. The number of devices 

is not limited. 

Supported connection methods: 

 Internet over Cloud Server; 

 Wi-Fi client and access point; 

 Bluetooth; 

 Ethernet by IP or URL; 

 USB OTG (Android only that support USB OTG); 

http://remotexy.com/ru/
http://remotexy.com/en/download/


 

 32 

Supported boards: 

 Arduino UNO, MEGA, Leonardo, Pro Mini, Nano, MICRO and compatible 

AVR boards; 

 ESP8266 boards; 

 ESP32 boards; 

 Chip KIT UNO32, Chip KIT uC32, Chip KIT Max32; 

Supported communication modules: 

 Bluetooth HC-05, HC-06 or compatible; 

 Bluetooth BLE HM-10 or compatible; 

 ESP8266 as modem; 

 Ethernet W5100; 

Supported IDE: 

 Arduino IDE; 

 FLProg IDE; 

 MPIDE; 

Supported mobile OS: 

 Android; 

 iOS; 

Remote XY is easy way to make a unique graphical interface to control microcontroller 

device via mobile application, Arduino for example. 

Remote XY allows:  

 To develop any graphical management interface, using the control, display and 

decoration elements any combination thereof. You can develop the graphical 

interface for any task, placing the elements on the screen using the online editor. 

Online editor posted on the website remotexy.com. 

http://remotexy.com/en/
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 After the development of the graphical interface, you get the source code for the 

microcontroller that implements your interface. The source code provides a 

structure for interaction between your program with the controls and display. Thus 

you can easily integrate the control system into your task for which you are 

developing the device. 

 To manage microcontroller device using your smartphone or tablet with the 

graphical interface. For manage used mobile application Remote XY. 

 Using one mobile application, you can manage a large number of devices with 

different graphical management interfaces. As the interface description is stored on 

board the microcontroller device. 

the source code for the microcontroller, for example a sketch for the Arduino, you 

opened it in the IDE. In the simplest case, you can download the sketch in Arduino 

board and test your interface immediately, connecting via a smartphone. But often 

you need to integrate the developed graphical interface with your problem you want 

to solve it using the Arduino. Next, we will show how it is easy to do. 

The generated source code have a part that is starts with tag Remote XY include 

library and ends with tag END Remote XY include. This part of the code defines 

the structure of the graphical interface that you have created. In turn, this structure is 

also divided into parts. Consider the order. 

Select connection mode and include library 

The code contains a definition of how you use the connection of interface. This definition 

of the form REMOTEXY_MODE__ XXX. For example, if you use Software Serial, this 

definition would be REMOTEXY_MODE__SOFTWARESERIAL, if you use Hardware 

Serial - REMOTEXY_MODE__SERIAL respectively. 

Additionally this section of code contains the necessary includes libraries to provide the 

necessary functionality. Also connects library Remote XY.h. There is no need to change 

this part of code. 
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Connection settings 

This part of the code in more detail defines the characteristics of the selected connection. 

For example, if you are using a connection via Software Serial, you can determine which 

pins microcontroller will be connected to the Bluetooth module. You can also determine 

the rate of exchange with the Bluetooth module, if it is different from the default 9600 baud. 

All definitions are set by default, but you can change them as you need. This is the only 

section of code in the included section of Remote XY that you can change. 

 

ESP8266 Wi-Fi module 

ESP8266 module allows to use RemoteXY with microcontroller device for Wi-Fi. 

Implemented support for all Arduino boards. The source code of GUI can be download for 

the Arduino IDE and PLProg. 

Remote XY allows to configure module for operate in one of two modes: access point and 

client. Client allows to connect the module to an existing Wi-Fi access point.Access point 

mode of ESP8266 configures the module as an access point and allows to connect Arduino 

directly to this point. The access point is available to connect to it from smartphone or tablet 

within a radius of availability of the radio signal. It does not require any other network 

infrastructure. This connection mode can be used in the far away place where there is no 

computer networks and the Internet. To configure this mode in the configuration properties 

of editor need to select the type of connection "Wi-Fi access point." 

Client mode of ESP8266 configures the module for automatically connect to an existing 

Wi-Fi access point, such as a home router or enterprise access point. At the same time 

connected to the Arduino module ESP8266 must be located in the physical availability of 

the radio signal of access point. Connecting to the device from smartphone or tablet will be 

not directly, but through the Ethernet network, an IP address provided by the DHCP server 

to ESP8266 module. It allows to connect to the Arduino device from anywhere in the local 

network as well as from the Internet.  
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CHAPTER 4 

METHODOLOGY 

 

4.1 Our methodologies for the project: 

 Creating an idea for the design and construction of Automatic IoT Fishering 

Management System. And designing a block diagram to know which 

components we need to construct it.  

 Collecting all the components for our desired system. 

 Setting up all the components in a system. Then assembling all the blocks in 

a system and finally running the system to check if it actually works or not. 

 

4.2 Our Final System view 

 

Figure 4.1: Our Final System Overview (Side View) 
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Figure 4.2: Our Final System Overview (Top View) 

 

 

4.3 Working Principle 

Our Project is Automatic IoT Fishering Management System. In this project we used a 

Node MCU as the brain of the whole project. As an input we used three sensors. In this 

project we used a LCD Display and mobile for output device. We used SMPS and rectifiers 

to power the entire project. At first SMPS convert AC to AC step down voltage & this 

voltage convert AC to DC via rectifier Circuit. Here we use ultrasonic sensor for measure 

the water level of the pond. Here also use a temperature sensor  which will detect water 

temperature and rain sensor will observe the weather condition of the pond area. All data 

will show in LCD display and mobile display through IoT. This is the main procedure off 

our system.   
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CHAPTER 5 

RESULTS AND DISCUSSION 

 

5.1 Discussion 

In this project we added all of this equipment and setup it properly. Then observe our system. 

In the very beginning time, we can’t do it properly, after a great teamwork we solve our 

problem and finally able to measure water level, water temperature and weather condition like 

rain and end notification in our phone, After using this system we really know our pond 

condition.  

 

5.2 Results 

Types of Sensors Minimum Value Maximum Value 

Temperature Sensor 26oC 34oC 

Rain Sensor No Rain Rain Detected 

Ultrasonic Sensor Level 6 Level 14 

 

5.3 Advantages 

There are certainly many advantages of our project and some of the major ones have been 

given below: 

 Check  temperature automatically. 

 No Oil consumption. 

 The project is compact, cheap and user friendly. 

 The whole system consumes very little energy. 

 Less skill technicians is sufficient to operate.  

 Simple construction  

 Ease of operation 

5.4 Applications 

This project has applications in many fields due its necessity. We have selected a few of 

them and they are given below: 
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• It can be used for Smart Poultry and Fishery Farm work. 

• It can be used for maintain temperature and weather monitoring automatically.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 39 

CHAPTER 6 

CONCLUSION 
 

6.1 Conclusion: 

IoT is an innovative technology for Zoology environmental condition management 

especially fishery farming which can be changed from the routine traditional farm into 

smart automated fishery farm. In this paper we have presented IoT based fishery 

management smart system for managing and improve the fish productions in fish farming 

ponds. The current implemented system consists from the most vital sensors that are needed 

to monitor the water quantity and notify the fish pond manager on-site. In future we plan to 

expand the IoT water monitoring system by adding a variety of other sensors, like sensors 

that will measure pH or dissolved oxygen vital for the fish life cycle. This work represents 

the design and implementation of fishery system monitoring system. IOT technology is 

applied while developing this system. It is scalable, mobile and accurate. This will help to 

increase the fish production to a significant level. Further there is no need for manual 

testing, reduction of losses saves the labour cost, and also prevention of critical condition. 

It is difficult to manage the fish farms with traditional and non-technical methods. The 

developed model provides the technological solution which would monitor the quality of 

the water in real time. 

 

6.2 Future Scope 

As we have already discussed about the limitations of our project so definitely there’s room 

for improvement and thus, we have lots of future scope of work available to us for this 

project. Some of these are listed below: 

 In future, we are thinking about adding record for save some data. 

 In future, we are thinking about 100% accuracy. 

 In future development this project can be develop by more gas sensor, thermal 

image sensing, camera etc. for security. 

 In the future we will use anti thief alarming system. 
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